
 

How-To: Create a Custom Home Page  
Introduction This resource was created to walk you step-by-step through creating an 

attractive and useful Front Page to serve as a home page for your Canvas 
course. This presentation is self-paced, giving you time to follow along in your 
own course.  
 

1. Getting Started Open the course that you wish to make a new Home page for.  
Navigate to that course’s Pages page.  
 

2. Create a New 
Page 

Click the +Page button at the top right. 
Give the new page a title such as “Welcome” or “Home”. 
 

3. Add Content Now it’s time to add content to this page. Think about what you want your 
students to see when they enter your course every time they visit. What 
would be most useful for them to have easy access to? Use the menu below 
to learn how to create each of these types of page content. 
 

Find in this document:  
• Add One or More Images [Page 2] 

o Stock Photos [Page 2] 
o Course Images [Page 3] 
o Upload Image [Page 4] 
o User Images [Page 5] 

• Add Text to Your Page [Page 6] 
• Create Links to Other Parts of The Course [Page 7] 

o Add a Text Link to Your Page [Page 7] 
o Add an Image Link to Your Page [Page 8] 
o Making “Buttons” [Page 9] 

• Include a Video [Page 10] 
o Include a Course Intro Video [Page 10] 
o Include an Informal Welcome Video [Page 11] 
o Include a YouTube Video [Page 12] 

• Add Documents and Files [Page 13] 
 

4. Save and Publish 
Your Page 

Once you are done putting content on your page, it’s time to save and publish 
it so it can be used as your course’s Home Page. At the bottom of the page, 
click Save & Publish. 
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5. Designate Your 
Page as the Front 
Page 

Once your page is published, click the three-dot icon at the top left and select 
Use as Front Page from the menu. Once you do this, that page will get a 
“Front Page” badge in the Pages list.  
 

6. Set the Course 
Home Page 

Return to your course’s current Home Page by clicking the Home link at the 
top of the left-hand course navigation menu. Click the Choose Home Page 
button on the right [1], then select Pages Front Page [2] and click Save [3]. 
 

Your New Course 
Home Page 

Your course Home Page is now set to display the page you designated as a 
Front Page.  
 
Should you want to edit this page, you can do so in the same way you’d edit 
any other page in your course.  
There can be only one page designated as Front Page at a time. If you 
designate another page as the Front Page, the original will lose that status.  
You may choose another Home Page (e.g. Modules or Assignments) at any 
time by clicking the Choose Home Page button (Step 6).  
 
Questions? Educational Software Consulting is here to help! Email us at 
edtech@teaching.pitt.edu. 
 

Add One or More Images 
Add One or More 
Images 

Adding images to your home page can help both you and your students orient 
themselves to which course they are working in, as well as provide visual 
interest or information about the course content and faculty. 
 
Using the Rich Content Editor (RCE), you can add images to your pages using 
the Insert Image button in the toolbar. 
 

 Click the down arrow next to the Insert Image button and select: 
Upload Image to upload an image that you have on your computer (this is the 
most common) or to insert a royalty-free stock photo from the integrated 
Unsplash service. 
Course Images to insert an image you have previously uploaded to this 
course. 
User Images to insert an image you have previously uploaded to your user 
files (files associated with your user account, not a course). 
 

Add One or More Images: Use Stock Photos 
Stock Photo Step 1 Find the Insert menu or the Add Image button 

 
Stock Photo Step 2 Select Upload Image from the menu 

 
Stock Photo Step 3 Click the Unsplash tab 
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Unsplash is a royaly-free Creative Commons stock photo service now 
integrated with Canvas.  
 

Stock Photo Step 4 Type a key word or words into the Search box 
Click on the image you want to use to select it. 
 

Stock Photo Step 5 Enter Alt Text (or Designate as a Decorative Image) 
After selecting an image, scroll down to address important accessibility 
settings.  
 
Alt Text is what a blind student using a screen reader to access your course 
will hear when they reach the part of the page with the image. Images that 
contain information, course content, or contribute to the students’ 
understanding of course materials should have descriptive alt text that fully 
describes the image. 
 
Below the Alt Text box is a checkbox to instead designate the image as 
decorative. Decorative images are ignored by assistive technologies used by 
blind students. This box should be checked for images that do not contribute 
to informational course content or the students’ experience in the course.  
 
Click Submit when you are done.  

Stock Photo Step 6 Access Image Options to resize or edit 
Once the image is inserted, click anywhere on it to access Image Options. Click 
the Image Options pop-up text to get a slide-out menu on the right. 

Stock Photo Step 7 Resize the image  
Images that are too large can make your page hard to read. You can easily 
resize the image by changing the pixel dimensions or using the pre-set size 
dropdown menu. Click “Done” when you are finished. 

Add One or More Images: Course Images 
Course Image Step 
1 

Find the Insert menu or the Add Image button 
Course images are images that you have previously uploaded to this course 
and wish to re-use.  
 

Course Image Step 
2 

Select Course Images from the menu 
 

Course Image Step 
3 

Browse the images that have been uploaded to your course 
Click on the image you wish to add to the page.  
 

Course Image Step 
4 

Access Image Options to resize and create Alt Text 
Once the image is inserted, click anywhere on it to access Image Options. Click 
the Image Options pop-up text to get a slide-out menu on the right. 
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Course Image Step 
5 

Enter Alt Text (or Designate as a Decorative Image) 
Use the Image Options to address important accessibility settings.  
 
Alt Text is what a blind student using a screen reader to access your course 
will hear when they reach the part of the page with the image. Images that 
contain information, course content, or contribute to the students’ 
understanding of course materials should have descriptive alt text that fully 
describes the image. 
 
Below the Alt Text box is a checkbox to instead designate the image as 
decorative. Decorative images are ignored by assistive technologies used by 
blind students. This box should be checked for images that do not contribute 
to informational course content or the students’ experience in the course.  
 

Course Image Step 
6 

Resize the image  
Images that are too large can make your page hard to read. You can easily 
resize the image by changing the pixel dimensions or using the pre-set size 
dropdown menu. Click “Done” when you are finished. 
 

Add One or More Images: Upload Image 
Upload Image Step 
1 

Find the Insert menu or the Add Image button 
 

Upload Image Step 
2 

Select Upload Image from the menu 
 

Upload Image Step 
3 

Drag and drop an image or click anywhere in the dotted line 
 

Upload Image Step 
4 

Enter Alt Text (or Designate as a Decorative Image) 
After uploading your image, scroll down to address important accessibility 
settings.  
 
Alt Text is what a blind student using a screen reader to access your course 
will hear when they reach the part of the page with the image. Images that 
contain information, course content, or contribute to the students’ 
understanding of course materials should have descriptive alt text that fully 
describes the image. 
 
Below the Alt Text box is a checkbox to instead designate the image as 
decorative. Decorative images are ignored by assistive technologies used by 
blind students. This box should be checked for images that do not contribute 
to informational course content or the students’ experience in the course.  
 

 Click Submit when you are done.  
 

Upload Image Step 
5 

Access Image Options to resize or edit 
Once the image is inserted, click anywhere on it to access Image Options. Click 
the Image Options pop-up text to get a slide-out menu on the right. 
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Upload Image Step 
6 

Resize the Image  
Images that are too large can make your page hard to read. You can easily 
resize the image by changing the pixel dimensions or using the pre-set size 
dropdown menu. Click Done when you are finished. 
 

Add One or More Images: User Images 
 
User Image Step 1 Find the Insert menu or the Add Image button 

User images are images that you have previously uploaded to your Canvas 
user files. This is a fairly rare circumstance.  
 

User Image Step 2 Select Course Images from the menu 
 

User Image Step 3 Browse the images that have been uploaded to your user account 
Click on the image you wish to add to the page. 

User Image Step 4 Access Image Options to resize and create Alt Text 
Once the image is inserted, click anywhere on it to access Image Options. Click 
the Image Options pop-up text to get a slide-out menu on the right. 
 

User Image Step 5 Enter Alt Text (or Designate as a Decorative Image) 
Use the Image Options to address important accessibility settings.  
 
Alt Text is what a blind student using a screen reader to access your course 
will hear when they reach the part of the page with the image. Images that 
contain information, course content, or contribute to the students’ 
understanding of course materials should have descriptive alt text that fully 
describes the image. 
 
Below the Alt Text box is a checkbox to instead designate the image as 
decorative. Decorative images are ignored by assistive technologies used by 
blind students. This box should be checked for images that do not contribute 
to informational course content or the students’ experience in the course.  
 

User Image Step 6 Resize the image  
Images that are too large can make your page hard to read. You can easily 
resize the image by changing the pixel dimensions or using the pre-set size 
dropdown menu. Click “Done” when you are finished. 
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Add Text to Your Page 
 
 Text in multiple sizes and formats can be added to your page to present 

information and describe images.  
 
The Rich Content Editor (RCE) provides several text formatting options, but to 
keep your page accessible for users with disabilities, please keep the following 
in mind: 
Use the text styles dropdown menu to create headers and subheaders rather 
than increasing font size or using bold text. 
If you use tables to format your page or present data, or used colored text, be 
sure to use the Accessibility Checker and follow its instructions for adding 
table captions and headers.  
 

Add Text Step 1 Highlight text to add formatting or use it as a link 
The Canvas Rich Content Editor (RCE) behaves much the same as popular 
word processing applications you are already familiar with.  
 

Add Text Step 2 Use the Styles dropdown to create headings and subheadings 
The Styles dropdown menu is an important accessibility tool. Use this for 
creating section headings and subheadings rather than increasing text size or 
using bold/italic text to designate a new section of the page. 
 

Add Text Step 3 Center text with the alignment menu 
The alignment menu will change the alignment of the highlighted text or 
paragraph. 
 

Add Text Step 4 Create links to other websites with the link button 
Highlight the text you wish to be a link, click the link button and select 
External Link 
 

Add Text Step 5 Enter Alt Text (or Designate as a Decorative Image) 
Use the Image Options to address important accessibility settings.  
 
Alt Text is what a blind student using a screen reader to access your course 
will hear when they reach the part of the page with the image. Images that 
contain information, course content, or contribute to the students’ 
understanding of course materials should have descriptive alt text that fully 
describes the image. 
 
Below the Alt Text box is a checkbox to instead designate the image as 
decorative. Decorative images are ignored by assistive technologies used by 
blind students. This box should be checked for images that do not contribute 
to informational course content or the students’ experience in the course.  
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Add Text Step 6 Resize the image  
Images that are too large can make your page hard to read. You can easily 
resize the image by changing the pixel dimensions or using the pre-set size 
dropdown menu. Click “Done” when you are finished. 
 

Create Links to Other Parts of the Course 
 Since this is the first page that students will land on every time they enter 

your course, you may want to include links that help them navigate to the 
most important parts of the course.  
 
Links can be made from text, or from images. They can link to other parts of 
the same course, or other websites outside of Canvas. Use the menu below to 
select the type of link you’d like to make.  
 

Add a Text Link to Your Page 
Text Link Step 1 Highlight the text you want to use as a link 

The Canvas Rich Content Editor (RCE) behaves much the same as popular 
word processing applications you are already familiar with.  
 

Text Link Step 2 Use the Link dropdown to select the type of link 
With the text still highlighted, click the Link dropdown and select either 
external or course link. An External Link is a link to a site outside of your 
course. Even other Pitt-associated links are considered external. A Course Link 
is a link to some other part of your course or piece of course content.  
 

Text Link Step 3 Creating an External Link 
If you select “external” for your link, you will get a pop-up with a field to paste 
or type in the link you want to send users to when they click the highlighted 
text. Then click “Done.” 
 

Text Link Step 4 Create a Course Link 
Highlight the text you wish to be a link, click the Link button and select Course 
Link. A panel will slide out from the right displaying several sub-menus that 
can be expanded by clicking the > arrows. The first six menus allow you to 
select specific items to link to from your course content, such as a particular 
assignment or single discussion board. The final menu, called Course 
Navigation, allows you to link to an entire area of your course, such as the 
Assignments or Discussions areas. Please note that you can create links to 
many parts of your course as well as course content, but not all. Click on the 
content item or area of your course that you wish to link to create the link. 
Close the panel with the X at the top right. 
 

Text Link Step 5 Remove or Edit a Link 
After creating either an external or course link, the link may be edited or 
removed if necessary. Click to place your cursor anywhere within the linked 
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text (you do not need to highlight the entire link) and click the Link dropdown 
again. You can choose to either edit the link or remove it entirely. 
 

Add an Image Link to Your Page 
Image Link Step 1 Place an image onto your page 

This tutorial will begin after you’ve already added an image to your page that 
you want to use as a link.  
 
If you need instructions for how to put an image onto your page, click here to 
jump to the tutorial. Remember, alt-tags for images are required for 
accessibility, and are especially important if you are using images as links! 
 

Image Link Step 2 Click the image to select it 
Single-click the image to select it. You will know it has been selected when 
you see that it has a blue border around it with four square “handles” at the 
corners. Do not click the Image Options pop-up.  
 

Image Link Step 3 Use the Link dropdown to select the type of link 
With the image still selected, click the Link dropdown and select either 
External or Course Link. An external link is a link to a site outside of your 
course. Even other Pitt-associated links are considered external. A course link 
is a link to some other part of your course or piece of course content.  
 

Image Link Step 4 Creating an External Link 
With the image you wish to be a link selected, click the link button and select 
External Link. You will get a pop-up with a field to paste or type in the link you 
want to send users to when they click the image. Then click Done to save the 
new link. 
 
(Step 5 covers the creation of a Course Link.) 
 

Image Link Step 5 Creating a Course Link 
With the image you wish to be a link selected, click the link button and select 
Course Link.  
 
A panel will slide out from the right displaying several sub-menus that can be 
expanded by clicking the > arrows. The first six menus allow you to select 
specific items to link to from your course content, such as a particular 
assignment or single discussion board. The final menu, called Course 
Navigation, allows you to link to an entire area of your course, such as the 
Assignments or Discussions areas.  
 
Please note that you can create links to many parts of your course as well as 
course content, but not all. Click on the content item or area of your course 
that you wish to link to create the link. Close the panel with the “x” at the top 
right—the new link is automatically saved. 
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Image Link Step 6 Remove or Edit a Link 
After creating either an external or course link, the link may be edited or 
removed if necessary. Click to select the image and then click the Link 
dropdown again. You can choose to either edit the link or remove it entirely. 
 

Making “Buttons” 
Making Buttons 
Step 1 

Understanding Buttons 
“Buttons” that you see on web pages (such as the “Menu” button below) are 
simply images that have been used as links. When the user clicks on the 
image, they are taken to the location specified by the link. The process for 
creating the link for a button on your Canvas course home page is the same as 
creating any other image link but you may be wondering how one creates 
such an image in the first place.  
There’s no need to be a graphics expert to make customized buttons—you 
can use PowerPoint to do it quickly and easily by following these instructions.  
 

Making Buttons 
Step 2 

Open a new PowerPoint presentation 
Open PowerPoint and select Blank Presentation. If there are any text boxes 
or placeholders on the new presentation, you can delete them, they will not 
be needed.  
 

Making Buttons 
Step 3 

Insert a box, rectangle or other shape 
Using the Insert menu, use the Shapes dropdown to select a shape to use as 
your button. A button can be any shape, though a rectangle or rounded 
rectangle are typical. Once you have selected the shape, drag and drop on the 
slide to create the button. (Tip: Make sure your display is zoomed to 100% so 
you get an accurate idea of how big it is.) 
 

Making Buttons 
Step 4 

Label and customize your button 
By double-clicking inside the shape you drew in Step 3, you will be able to 
type into it. You can now also customize your button’s fill color and outline 
with the Format menu. 
 

Making Buttons 
Step 5 

Save your button as an image 
Once you are happy with your button’s shape, size, color and text, you can 
now save it as an image. Right-click on the button and select Save as Picture. 
Save the image to a location on your computer where you will remember 
where you put it (and give it a name that will help you distinguish it from 
other images).  
 

Making Buttons 
Step 6 

Make the next button 
Now that you’ve saved the first button as an image, you can go back to your 
PowerPoint slide and replace the text with the text of the next button you 
want to create. This will help you keep your buttons a consistent size and 
format. Save it using the right-click Save as Picture method and give it a 
different name from the original button. Since you are saving each button as a 



 

10 
 

separate image, you do not need to save this PowerPoint slide at any point--
you’re just using it as a method to create button images. 
 
You can now upload these images to your Canvas page and link them to 
external or course links as outlined in other areas of this tutorial. Remember 
that it is important that image links have descriptive alt-text 

Include a Video 
 It may be beneficial to include a video on your Home page. This video could 

be an introduction to you and how-to for using your course, an informal 
welcome to your students or perhaps a video about an inspiration in your 
field.  
 
Videos can be included in Canvas in a number of different ways. Select from 
the options below to learn about best practices and get instructions for each.  

Include a Course Intro Video 
Course Intro Step 1 What’s a Course Intro Video? 

Typically, a course introduction video spends about 5 minutes introducing 
yourself as the course instructor and then showing the students around the 
Canvas course site using screen capture video. This will help ensure that 
students know what your expectations are for their use of Canvas, as well as 
showing them where to see their assignments, quizzes, course content and 
course announcements. Every instructor designs their Canvas course a little 
differently, so this can be extremely beneficial to students who are taking a 
full course load and must navigate many differently designed courses per 
semester. 
 
Because of the need for screen capture in order to create this type of video, 
we recommend using Panopto for this. Panopto is fully integrated with 
Canvas and the steps we give here take advantage of that integration. 
 

Course Intro Step 2 Enable Panopto Video for your Canvas course 
To link your course up with Panopto, you must first enable the Panopto Video 
course menu item. In your course, click on Settings and then the Navigation 
tab. Once there, find Panopto Video and make sure it is enabled. If it is not, 
click the three-dot icon and select Enable. Then click Save at the bottom of 
the page 
 

Course Intro Step 3 Choose a Panopto Recording Application 
Click the Panopto Video link in your course menu, then click the blue Create 
dropdown at the top of the page. You may use the Panopto for Windows 
desktop application (Panopto Recorder instructions here) or the new Panopto 
Capture web-based recorder (instructions in the next step). 
 

Course Intro Step 4 Record your video 
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When opening Panopto Capture, you will be asked by your browser to verify 
that your camera and microphone have permission to connect with Panopto. 
Click Allow on these prompts. To record your screen as you give a “tour” of 
your Canvas course, click the Screens and Apps button at the top right, select 
your browser and click Allow. You will likely get a “hall of mirrors” effect—this 
is normal and expected. The red button at the bottom of the page is your 
record button. You’ll get a 5-second countdown once you click it. As you begin 
recording you may navigate to the browser tab that Canvas is running in and 
begin your video. It may not appear that anything is being captured, but it is.  
 
When you are finished, navigate back to the Panopto tab and click the red 
square. Your video will upload to Panopto automatically. Look to the top right 
for a message about when it’s safe to close this browser window. See also the 
“Redo” button at top right to delete this video and start all over again. 
 
 

Course Intro Step 5 Edit your video and add captions 
Back in your Canvas course, go back to the Panopto Video area and refresh 
the page to see the video you just recorded. To insert automatic closed 
captions into your video, mouse over your video and click the Edit button. 
Select the Captions tab at top right [1], pull down the Import captions menu 
[2] and select Import automatic captions [3]. Edit any captions that are 
inaccurate. Click Apply at the top of the screen to save. See our article about 
editing in Panopto for more information about editing videos.  
 

Course Intro Step 6 Embed the video in your Home Page 
Navigate to the Home Page you’ve been working on in the Pages area of your 
course (or create a new one). Click Edit to begin editing this page and place 
your cursor at the part of the page that you want the video to appear. In the 
toolbar at the top of the screen find the Panopto Icon, which resembles a 
green triangle. Choose the video you made previously by selecting its radio 
button. Click Insert. 
 

Include an Informal Welcome Video 
Welcome Video 
Step 1 

A short, informal welcome video 
Canvas includes some built-in video-recording features that you can take 
advantage of if you want to quickly and easily make a short, informal video 
welcoming your students to your course. Canvas’s video tool does not allow 
for screen capturing or editing, so we do not recommend using it for longer 
videos or videos that require editing or effects. 
 

Welcome Video 
Step 2 

Locate the Record/Upload Media button 
Click on the part of your page that you’d like the video to appear. In the 
toolbar, click the down-arrow next to the Record/Upload Media button in the 
Rich Content Editor (RCE) toolbar and select Upload/Record Media.  
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Welcome Video 
Step 3 

Choose to record media 
In the pop-up, click on the Record Media tab.  
 
Note: If you wish to record your video using some other application on your 
computer, you can use the Upload Media tab to upload and embed that video 
instead. 
 

Welcome Video 
Step 4 

Grant your browser permission to access camera and microphone 
Your browser will pop up a dialogue asking you to give permission to access 
your webcam and microphone. If you have multiple video or audio devices 
connected to your computer, the dropdown menus will allow you to select 
which devices you want to use for the recording. (Note: Every browser’s 
dialogue window will look and behave slightly differently. Pictured below is 
Firefox.) 
 

Welcome Video 
Step 5 

Record your video 
You can adjust your microphone and camera choices (or turn off your camera 
entirely) before recording your video. Click the Record button to begin and 
the Finish button to end your recording. Once you have finished your 
recording, you can give it a name and click Save, or the Start Over button to 
delete what you recorded and start over. 
 

Welcome Video 
Step 6 

Video Options 
Once you’ve saved your video, it will automatically embed on your page. 
Clicking on it will pop up a Video Options button. This will give you the ability 
to rename the video, adjust its size on the page, as well as upload a closed 
caption file. Unfortunately, at this time Canvas does not offer autocaptioning 
for video. For information about using free third-party tools to create captions 
and upload them to your Canvas videos, see this captions documentation 
from Canvas.  
 

Include a YouTube Video 
YouTube Video 
Step 1 

Including videos from other sources 
If there’s a video from YouTube or another video hosting platform that you’d 
like to include on your home page, you can do that using either Canvas’s 
YouTube integration. Videos from other sources (such as Vimeo) can be 
embedded using their embed code. 
 

YouTube Video 
Step 2 

Opening the YouTube Plug-In 
Find the Plug-In icon in the Rich Content Editor tool bar and pull down its 
menu to find the YouTube plug-in. A pop-up window will appear where you 
can search YouTube for videos. Tip: If you already have the URL for the video 
you want to use, you can paste that into the search field to locate that video. 
 

YouTube Video 
Step 3 

Selecting a video 
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Once you’ve searched and found the video you want to embed, you can 
either click the Embed button or click the arrow next to the Embed button to 
select the size you want the video. As soon as you select the embed, the 
window will close, and the video will now appear on your page.  
 

YouTube Video 
Step 4 

Embedding media from other sources 
A number of different multimedia hosting services (e.g. Vimeo, Soundcloud or 
Scribd) provide embed codes that allow you to embed their resources into 
other websites, like Canvas. If you have such code, you can add the resource 
to your page by going to the Insert menu and selecting Embed.  
 
Paste the code into the box provided and click Submit. 
 

Add Documents and Files 
 You can include embedded or linked documents and files to your front page, 

such as a syllabus, an important reading, or course policies.  
 
When you upload a document, you have the choice to automatically embed a 
preview, make the preview optional, or disable it entirely. No matter what 
you choose, your students will always be able to download the document in 
order to save or print it on their own. 

Add Documents 
Step 1 

Insert a document 
Click the down-arrow next to the Insert Document icon to find three choices 
for where this document will be retrieved from: your own computer (Upload 
Document), a file that has already been uploaded to your course previously 
(Course Documents) or a file that has already been uploaded to your personal 
user files previously (User Documents).  
 
To upload from your computer, click Upload Document.  
 

Add Documents 
Step 2 

Upload a File from Your Computer 
Either drag-and-drop or click anywhere inside the dotted line to open a file 
browser to find the document you want to upload. Click Submit once you 
have located the correct file.  
 

Add Documents 
Step 3 

Insert a file that’s already been uploaded 
You can insert a link to a document or file that’s already been uploaded to 
your course and included in other course content by selecting Course 
Documents from the Insert Document menu. A panel will slide on the right 
allowing you to browse all the files in your course to find the one you want. 
Click on the one you want to add. 
 

Add Documents 
Step 4 

Understanding file previews 
In Canvas, a file preview displays certain types of documents (Word, 
PowerPoint, Excel, PDF as well as some less-commonly used formats—for 
more information see the Canvas documentation) right inside the Canvas 

https://community.canvaslms.com/t5/Instructor-Guide/What-types-of-files-can-be-previewed-in-Canvas/ta-p/607
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page without requiring students to download and open the document on 
their own computers. Students still have the option to download the 
document should they choose to, but can also view its contents inside Canvas. 
 
After you upload a file to your page, you have some options about how you 
want these previews to function. The default is to allow students to control 
how they preview the file, but there are other options. Click Step #5 to learn 
more. 
 

Add Documents 
Step 5 

Set preview options 
The default for documents inserted into pages is to allow the user to choose 
whether or not to open a full-sized document preview inside Canvas, by 
clicking the small “Preview the document” icon next to the file link [1]. 
 
You can alter this default behavior by clicking on the Link Options pop-up that 
appears when you click anywhere in the file link [2] and selecting either 
Disable in-line preview or Automatically open an in-line preview from the 
slide-out on the right [3]. 
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